
GRADUATE COUNCIL: NEW COURSE PROPOSAL 

Originating Unit: 

Type of action:                 New course           Full online course**      

Semester and year course will take effect: 

New course title: 

Appropriate computer abbreviation (30 spaces or less):  

Course instructional methodology: 

course coPSonenW W\Ses� uJrDGcouncil�Wcu�eGu�IorPs�&ourse &oPSonenW 7\Ses�SGI 

New course number:  

Prerequisites for new course: 

attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments

include an attachment if additional space is needed



Description of new course (catalog copy): include an attachment if additional space is needed

attached files can be seen and managed in Acrobat Pro by clicking on 
View > Show/Hide > Navigations Panes > Attachments



Does this change affect any other units of the University?          Yes          No 
If yes, submit supporting statement signed by chair of affected unit. 

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and 
the cross-listed units. 

Fully Online Courses** 
All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state 
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.  
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.  
Contact the Koehler Center for Teaching Excellence for guidelines.  Include a letter of support from the Koehler Center 
with this proposal. 

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives, 
course outline, and representative bibliography.�

Describe the intended outcomes of the course and how they will be assessed: include an attachment if 
additional space is needed

$GGLWLRQDO UHVRXUFHV UHTXLUHG: 

Faculty: 

Space: 

Equipment: 

Library: 

Financial Aid: 

Other: 

Change in teaching load:

attached files can be seen and managed in Acrobat Pro by clicking on 
View > Show/Hide > Navigations Panes > Attachments
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Signature: 



TEXAS CHRISTIAN UNIVERSITY 
School of Music 

 
Fall 2023 

  
MUSI 60420 

Graduate Symphony Orchestra – Strings 
MSC 124 

 
Conductor:              
    Dr. Germán Augusto Gutiérrez,  
Office:                          

MSC - 212   
817-257-7654  

Office hours:  
Tuesday and Thursday  
10:00 to 12:00 am or by appointment. 

 
Rehearsal times: 
 

Monday,Tuesday, and Thursday   3:30 to 5:20 PM 
 
Final Exam & Other Important Dates: 
 Concert #1 date – xx/xx/2023 
 Concert #2 date – xx/xx/2023 
 Final exam date – xx/xx/2023 
 
Method of Evaluation: 
 

1. Being well prepared for each rehearsal 
2. Attendance (see below) 

 
Being well prepared for rehearsal means knowing your part (i.e. not learning your part during 
rehearsal) and being ready to learn how your part contributes to the ensemble. This will be 
assessed throughout the semester.  
 
Attendance:  
 

1. Each unexcused absence from a rehearsal will result in lowering the final grade by one.  
When possible, director must approve absences two weeks in advance. Verification from 
the Dean of Students is required for an absence to be excused. 

2. Downbeat is at 3:30                                                                                                     
Prompt attendance at every rehearsal is required.  Two tardies equals one absence. 

3. Wind, brass and percussion players must attend all rehearsals in which they are involved.  



4. The weekly schedule of rehearsals will be sent by email. Students are responsible for 
consulting the daily rehearsal schedule with the orchestra conductor, or graduate assistant 
Offices in MSC 212 & 213. 

5. Performances are equivalent of exams.  Absence will result in a failing grade. 
 
Grading Scheme 

A – Well prepared for all rehearsals, no unexcused absences from rehearsals 
B – Well prepared for all rehearsals, one unexcused absence from a rehearsal 
C – Well prepared for all rehearsals, two unexcused absences from rehearsals 
F – Well prepared for all rehearsals, three or more unexcused absences from rehearsals 
 
OR 
 
F – Well prepared for all rehearsals, unexcused absence from a performance 

 
Communication 
Students will be notified of any changes in schedule via TCU E-MAIL ACCOUNTS.   Reading 
your TCU e-mail is your responsibility, and failure to do so will not be considered allowed 
excuses. 
 
An Orchestra Handbook will be provided along with this syllabus with more detail information 
about repertoire, concert dates, extra rehearsals and activities. 
 
Hearing Health and Injury Prevention 
The School of Music recognizes the importance of educating students about current musician 
health issues. As a part of their regular curricular study in the applied teaching studio, students 
and teachers will consider and discuss music-induced hearing loss and the prevention of 
performance related injuries. Students will also be made aware of the available professional 
resources to address these musician health issues by their instructor. 
    
 
Class Norms & Netiquette 
All members of the class are expected to follow rules of common courtesy in all email messages, 
discussions, and chats. If I deem any of them to be inappropriate or offensive, I will forward the 
message to the Chair of the department and appropriate action will be taken, not excluding 
expulsion from the course. The same rules apply online as they do in person. Be respectful of 
other students. Foul discourse will not be tolerated. Please take a moment and read some basic 
information about netiquette (http://www.albion.com/netiquette/). 
Participating in the virtual realm, including social media sites and shared-access sites sometimes 
used for educational collaborations, should be done with honor and integrity. Please review the 
relevant sections of the Student Handbook (https://deanofstudents.tcu.edu/student-handbook/) for 
TCU’s network and computing policies and communication guidelines. 
 
 
Email 



Only the official TCU student email address will be used for all course notification. It is your 
responsibility to check your TCU email on a regular basis. 
 
Course Materials 
TCU students are prohibited from sharing any portion of course materials (including videos, 
PowerPoint slides, assignments, or notes) with others, including on social media, without written 
permission by the course instructor. Accessing, copying, transporting (to another person or 
location), modifying, or destroying programs, records, or data belonging to TCU or another user 
without authorization, whether such data is in transit or storage, is prohibited. The full policy can 
be found at: https://tcu.policytech.com/dotNet/documents/?docid=55&public=true. 
Violating this policy is considered a violation of Section 3.2.8 of the Student Code of 
Conduct found in the Student Handbook (https://deanofstudents.tcu.edu/student-handbook/), and 
may also constitute Academic Misconduct or Disruptive Classroom Behavior. TCU 
encourages student debate and discourse; accordingly, TCU generally interprets and applies its 
policies, including the policies referenced above, consistent with the values of free expression 
and First Amendment principles. 
 
 
Academic Misconduct 
Academic Misconduct (Section 3.4 of the Student Code of Conduct found in the Student 
Handbook (https://deanofstudents.tcu.edu/student-handbook/)): Any act that violates the 
academic integrity of the institution is considered academic misconduct. The definitions and 
procedures used to resolve suspected acts of academic misconduct are available in the offices of 
the Academic Deans and Dean of Students, and are also listed in detail in the Undergraduate 
Catalog (http://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-
Policies/Academic-Conduct-Policy-Details) and the Graduate Catalog 
(http://tcu.smartcatalogiq.com/en/current/Graduate-Catalog/Academic-Conduct).  
Specific examples include, but are not limited to:  

• Cheating: Copying from another student’s test paper, laboratory report, other report, or 
computer files and listings; using, during any academic exercise, material and/or devices 
not authorized by the person in charge of the test; collaborating with or seeking aid from 
another student during a test or laboratory without permission; knowingly using, buying, 
selling, stealing, transporting, or soliciting in its entirety or in part, the contents of a test 
or other assignment unauthorized for release; substituting for another student or 
permitting another student to substitute for oneself.  

• Plagiarism: The appropriation, theft, purchase or obtaining by any means another’s 
work, and the unacknowledged submission or incorporation of that work as one’s own 
offered for credit. Appropriation includes the quoting or paraphrasing of another's work 
without giving proper credit. [If you are using Turnitin, place information about your 
course ID/password or state that items will be checked as part of the TCU Online 
assignment submission process. If you want to use Turnitin as a spot check, indicate that 
you may use Turnitin for plagiarism detection.] 

• Collusion: The unauthorized collaboration with another in preparing work offered for 
credit. 

• Abuse of resource materials: Mutilating, destroying, concealing, or stealing such 
material. 



• Computer misuse: Unauthorized or illegal use of computer software or hardware 
through the TCU Computer Center or through any programs, terminals, or freestanding 
computers owned, leased or operated by TCU or any of its academic units for the purpose 
of affecting the academic standing of a student. 

• Fabrication and falsification: Unauthorized alteration or invention of any information 
or citation in an academic exercise. Falsification involves altering information for use in 
any academic exercise. Fabrication involves inventing or counterfeiting information for 
use in any academic exercise. 

• Multiple submission: The submission by the same individual of substantial portions of 
the same academic work (including oral reports) for credit more than once in the same or 
another class without authorization. 

• Complicity in academic misconduct: Helping another to commit an act of academic 
misconduct. 

• Bearing false witness: Knowingly and falsely accusing another student of academic 
misconduct. 

 
TCU Online: Our Learning Management System 
Getting Started with TCU Online 
Technical Requirements: Check your computer is ready by looking at the specifications list. 
(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements) 
 
Log In: (using your TCU Network Credentials) 
Option 1: Access via my.tcu.edu > Student Quick Links > TCU Online 
Option 2: Login at http://d2l.tcu.edu 
*For information about logging into TCU Online, view these instructions 
(http://tcuonline.tcu.edu/kb/how-do-i-log-in/). 
Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online 
Student Orientation Tutorial, please do so now. To access it, click on the Orientations semester 
OR view all courses in your My Courses widget visible upon logging in to TCU Online. Click on 
the "Student Orientation Tutorial” to enter the orientation course. Follow the instructions in the 
course. You can return to this tutorial at any time. 
 
Getting Help with TCU Online 
If you experience any technical problems while using TCU Online, please do not hesitate to 
contact the D2L HELP DESK. They can be reached by phone or chat 24 hours a day, 7 days a 
week, 365 days a year.  
Phone: 1-877-325-7778 
Chat: Chat is available within TCU Online in the Help menu on the navigation bar. 
If you are working with the helpdesk to resolve a technical issue, make sure to keep me updated 
on the troubleshooting progress. 
If you have a course-related issue (course content, assignment troubles, quiz difficulties) please 
contact me. 
 
Personal Settings & Notifications for TCU Online 
As a student, you should set up your account settings, profile, and notifications. To do this you 
will login to TCU Online and select your name on the top right of the screen. You can upload a 



photo of yourself and add personal information to your profile. In the notifications area, you can 
add your phone number to receive text messages when grades are given, as well as reminder 
texts for upcoming assignments and quizzes.  
[You can direct students to these settings and notification pages as they give students the option 
to take more responsibility for their learning and planning by setting up custom email and text 
alerts for upcoming assignments and quizzes. You do not need to put in an additional email 
address or phone number.] 
 
Student Success Tools for TCU Online 
Pulse 
Pulse is a phone app which gives you access to the course calendar, assignments, grades, and 
announcements. This app provides a graph that can help you manage your time. Based on the 
number of assignments and events on the course calendar for your classes, the graph will display 
busy times for class work in the upcoming week. You can use this app to manage your daily 
workload, and it includes the ability to view and access course materials offline. You can 
download Pulse from the Google Play or Apple Store. You can learn more and download Pulse 
here: https://www.d2l.com/products/pulse/. 
[Pulse is a management tool for students to easily access information about the course from a 
mobile device. For Pulse to work well with a class, you should use the calendar tool in TCU 
Online. It is very important to use the course calendar due date function for readings, 
assignments, quizzes, and discussions in order to help populate the calendar used in Pulse.] 
 
ReadSpeaker 
ReadSpeaker includes a number of tools that can enhance your understanding and 
comprehension of course materials. ReadSpeaker can create an audio version of content that you 
can listen to while on a page within a course or that you can download to listen offline. 
ReadSpeaker can also read Microsoft Office files and PDFs. There are additional tools and 
features to assist you with reading and focusing in TCU Online, tools that provide support for 
writing and proofing text, and tools that can read non-TCU Online content aloud. You can learn 
more about how to use ReadSpeaker tools here: https://tcuonline.tcu.edu/how-to-hub/instructor-
how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/ 
[ReadSpeaker is a support tool for students to access written content in an audio format, 
improve their focus while on TCU Online content pages, and help them write and edit content in 
other TCU Online tools. To help students get the most out of ReadSpeaker, you should be sure 
that any PDFs they upload are able to be read by ReadSpeaker. Many PDFs, especially those 
that have been scanned from books or journals by a photocopier, must be converted into 
searchable text to allow it to identify text and read the words. Learn how to make your PDFs 
accessible to screen readers like ReadSpeaker for your students.] 
 
Support for TCU Students 
Campus Offices 

• Academic Advising (817-257-7486, Jarvis 104) 
• Brown-Lupton Health Center (817-257-7938 or 817-257-7940) 
• Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003) 
• Center for Writing (817-257-7221, Reed Hall 419) 
• Counseling & Mental Health Center (817-257-7863, Jarvis Hall 2nd floor) 



• Dean of Students (817-257-7926, the Harrison 1600) 
• Mary Couts Burnett Library: Reference Desk (817-257-7117)  
• Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1st floor) 
• Student Access & Accommodations (817-257-6567, The Harrison 1200) 
• Student Success (817-257-8345, Samuelson Hall, West Entrance) 
• Substance Use and Recovery Services (817-257-7100, Jarvis Hall 2nd floor) 
• Transfer Student Center (817-257-8345, Samuelson Hall, West Entrance)  
• Veterans Services (817-257-5551, Jarvis Hall 2nd floor) 

 
Anti-Discrimination and Title IX Information 
Statement on TCU’s Non-Discrimination Policy 
TCU is committed to providing a positive learning, living, and working environment free from 
unlawful discrimination, harassment, sexual misconduct, and retaliation. In support of this 
commitment, in its policy on Prohibited Discrimination, harassment, sexual misconduct and 
retaliation, TCU has a range of prohibited behaviors, including unlawful discrimination and 
harassment and related sexual and other misconduct based on age, race, color, religion, sex, 
sexual orientation, gender, gender identity, gender expression, national origin, ethnic origin, 
disability, predisposing genetic information, covered veteran status, and any other basis protected 
by law. The Office of Institutional Equity (OIE) is responsible for responding to all reports of 
discrimination, harassment, sexual misconduct and retaliation. 
 
Please use the following links to review TCU Policy 1.008 Prohibited Discrimination, 
Harassment, Sexual Misconduct and Retaliation or to review TCU Policy 1.009 Responding to 
Reports of Prohibited Discrimination, Harassment, Sexual Misconduct, and Retaliation.  
To make a report, you may call OIE at 817-257-8228, email oie@tcu.edu, visit us at The 
Harrison, Suite 1800 or click here: Make a Report. 
To learn about the Campus Community Response Team (CCRT) and Report a Bias Incident 
click here: https://inclusion.tcu.edu/campus-community-response-team/ 
 
Title IX 
TCU’s Title IX Coordinator works within OIE. Andrea McDew serves as TCU’s Title IX 
Coordinator. You may call 817-257-8228 to make a report, email oie@tcu.edu or 
a.mcdew@tcu.edu, or make a report here. Additional Title IX resources and information are 
available at https://www.tcu.edu/institutional-equity/title-ix/index.php. 
 
Mandatory Reporters 
ALL TCU employees, except confidential resources, are considered Mandatory Reporters. 
Mandatory reporters are required to immediately report to OIE any conduct that raises 
Discrimination, Harassment, Sexual Misconduct (Title IX or Violence Against Women 
(VAWA)) or Retaliation. Mandatory reporters cannot promise to refrain from forwarding the 
information to OIE. 
 
Confidential On-Campus Resources 
Campus Advocacy, Resources & Education 
https://care.tcu.edu | 817-257-5225 
 



Counseling & Mental Health Center 
www.counseling.tcu.edu | 817-257-7863 
 
Religious & Spiritual Life 
www.faith.tcu.edu | 817-257-7830 
 
On Campus Resources 
TCU Police 
www.police.tcu.edu | 817-257-8400 Non-emergency | 817-257-7777 Emergency 
 
TCU Policy for Religious Observations & Holidays 
“Students who are unable to participate in a class, in any related assignment or in a university 
required activity because of the religious observance of a holy day shall be provided with a 
reasonable opportunity to make up the examination or assignment, without penalty, provided that 
it does not create an unreasonable burden on the University.” For more information, please visit 
the TCU Policy for Religious Observations & Holidays webpage. 
 
Student Access and Accommodation 
Texas Christian University affords students with disabilities reasonable accommodations in 
accordance with the Americans with Disabilities Act and Section 504 of the Rehabilitation Act. 
To be eligible for disability-related academic accommodations, students are required to register 
with the TCU Office of Student Access and Accommodation and have their requested 
accommodations evaluated. If approved for accommodations, students are required to discuss 
their official TCU Notification of Accommodation with their instructors.  Accommodations are 
not retroactive and require advance notice to implement. The Office of Student Access and 
Accommodation is located in The Harrison, Suite 1200. More information on how to apply for 
accommodations can be found at  https://www.tcu.edu/access-accommodation/  or by calling 
Student Access and Accommodation at (817) 257-6567. 
 
Audio Recording Notification:  
Audio recordings of class lectures may be permitted by the instructor or as an approved disability 
accommodation through Student Access and Accommodation. Recordings are not to be shared 
with other students, posted to any online forum, or otherwise disseminated. 
 
Emergency Response Information 
View TCU’s L.E.S.S. is More public safety video to learn about Lockdown, Evacuate, and Seek 
Shelter procedures. (https://publicsafety.tcu.edu/less-is-more/) 
View the TCU Building Safety Maps that show the specific seek shelter locations and building 
rally points for evacuation. (https://publicsafety.tcu.edu/less-safety-maps/)  
View the TCU Evacuation Rally Point Map to see all rally points for evacuation. 
(https://publicsafety.tcu.edu/wp-content/uploads/2020/01/TCU-Rally-Point-Map.pdf)  
Download the Frogshield Campus Safety App on your phone. 
(https://police.tcu.edu/frogshield/). 
In the event of an emergency, call the TCU Police Department at 817-257-7777.  
 
 



 
 
 
 
 
 
 
 



Addendum 
SACSCOC Statement on Contact Hours 
 
The proposed new course, MUSI 60420 (Graduate Symphony Orchestra - Strings) will meet for 
330 minutes a week, or 5280 minutes (88 hours) for a 16-week semester. The course receives 
only 0.5 credits, so this far exceeds the minimum of 750 minutes of contact time required by 
SACSCOC for a 1-credit hour class. 




